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1. INTRODUÇÃO

1.1. BOT’N ROLL ONE A

1.1.1. A QUEM SE DESTINA O BOT’N ROLL ONE A?

O Bot’n Roll ONE A compatível com Arduino é um produto didático Open Source, que se destina a todos
os que desejam iniciar-se no mundo da robótica móvel mesmo não tendo grandes conhecimentos nas
áreas  de  eletrónica  ou  informática.  A  montagem  deste  robô  permite  o  contacto  com  alguns  dos
componentes eletrónicos mais comuns. As breves introduções aos componentes e explicação de alguns
conceitos  ao  longo  do  manual  de  montagem  permitem  uma  abordagem  introdutória  muito
enriquecedora, que complementa as instruções de montagem dos componentes eletrónicos.

Os que desejam iniciar-se na robótica encontrarão no Bot’n Roll ONE A a ferramenta ideal que lhes
permite montar um robô mesmo não tendo os conhecimentos básicos.

Os professores encontrarão no Bot’n Roll ONE A uma ferramenta de trabalho capaz de os auxiliar na
transmissão de conhecimentos aos seus alunos.  Da eletrónica  à programação, este robô, permite o
estudo de um vasto leque de conceitos numa perspetiva muito prática.

Os mais experientes vão encontrar neste kit robótico um desafio interessante. O Bot'n Roll ONE A possui
dois micro-controladores, um ATmega328 a 16MHz programável em C com o Arduino IDE que é em tudo
semelhante a um Arduino UNO e um PIC18F45K22 a 80Mhz programável  em C com o MPLABX da
Microchip e  que  é  fornecido  já  programado  com  firmware desenvolvido  pela  botnroll.com.  Uma
biblioteca  para  o  Arduino  IDE  desenvolvida  pela  botnroll.com  permite  a  interação  entre  os  dois
microcontroladores. É fornecido com um display LCD alfanumérico de 2 duas linhas e 16 caracteres por
linha.

A este robô pode ser ligado um vasto conjunto de shields compatíveis com Arduino como comunicação
sem fios, GPS, GPRS, e sensores para realizar diversas tarefas, permitindo-lhe inclusive participar nas
principais  competições  robóticas  nacionais  e  internacionais.  Estas  competições  são  sempre  muito
motivantes para os jovens aprenderem mais, e para verem novas soluções criadas por outras equipas.

Para mais informações regista-te em www.botnroll.com e mantém-te a par das novidades.
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1.1.2. CARACTERÍSTICAS PRINCIPAIS DO BOT’N ROLL ONE A

Micro-controladores: 1 ATmega328 + 1 PIC18F45K22

Tensão de alimentação: 7V a 15V CC

I/O's digitais: 14 (dos quais 6 permitem PWM)

Entradas analógicas: 6 (ATmega328) + 8 (PIC18F45K22)

Saídas dedicadas ao controlo de servos: 2 (PIC18F45K22)

Entradas para encoders: 2 (PIC18F45K22)

Conector para comunicação I2C: 4 (ATmega328)

Display LCD: Alfanumérico de 2x16 com regulação de contraste e luminosidade (PIC18F45K22)

Botões de pressão: 3 (PIC18F45K22)

Sensores de obstáculos: 2 (PIC18F45K22)

Buzzer: 1 (ATmega328)

LED´s de debug: 2

Motores: 2 (PIC18F45K22)

 Tensão nominal: 12V CC
 Corrente Nominal: 0.58A 
 Rotação sem carga: 285rpm 
 Binário nominal: 1.16Kg.cm
 Binário máximo momentâneo: 1.74Kg.cm

Dimensões: 205mm x 192mm x 85mm

Peso: 800g (kit base sem bateria)

Bateria fornecida: Ni-MH AA 12V 800mAh 

Outras características:

 Botão de reset;
 Circuito de medição da tensão da bateria;
 Permite a inclusão de um regulador de tensão dedicado à alimentação dos servos;
 Os micro-controladores comunicam por barramento SPI;
 Proteção contra sobre correntes por fusível lento de 4A.
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1.1.3. VISÃO GERAL DO BOT’N ROLL ONE A
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Fig. 1: Visão geral do Bot’n Roll ONE A
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1.2. A ROBÓTICA

1.2.1. NOTA HISTÓRICA

A  palavra  "robot"  surgiu  pela  primeira  vez  numa  peça  de  teatro  "RUR"
(Rossum's Universal Robots) escrita em 1920 por Karel Capek, um dramaturgo
Checoslovaco. Nessa peça, um personagem construiu vários homens artificiais
e com eles substituiu o trabalho dos homens. Foi a primeira vez que alguém
usou esta  palavra  para  designar  "homem artificial".  Na sua língua original
(Checa)  "Robota"  significa  "trabalho  forçado".  Talvez  derivado  deste
significado,  os  robôs  estejam  ligados  à  indústria  de  uma  forma  mais
acentuada.  Ainda  antes  desta  peça,  os  robôs  eram  chamados  "Automan"
pelos Gregos, cujo significado é "movimentar automaticamente".

1.2.2. AS TRÊS LEIS DA ROBÓTICA

Elaboradas pelo escritor  Isaac Asimov no seu livro de ficção  I, Robot
("Eu, Robô") estas leis dirigem o comportamento dos robôs:

1ª Lei: Um robô não pode ferir um ser humano ou,  por passividade,
permitir que seja ferido.

2ª Lei: Um robô deve obedecer às ordens que lhe sejam dadas por seres
humanos, exceto nos casos em que tais ordens contrariem a Primeira
Lei.

3ª Lei:  Um robô deve proteger  sua própria  existência desde que tal
proteção não entre em conflito com a Primeira e Segunda Leis.

O objetivo das leis,  segundo o próprio Asimov, era tornar possível a
existência  de  robôs  inteligentes  (as  leis  pressupõem  inteligência
suficiente para distinguir o bem do mal) e que não se revoltassem
contra  o  domínio  humano.  Mais  tarde  Asimov  introduziu  uma
última lei:

Lei Zero: Um robô não pode fazer mal à humanidade e nem, por impacção, permitir que ela sofra algum
mal.

A lei zero, porém, tem o sério problema de transferir ao robô o poder (possibilidade) de avaliar, diante
das  situações  concretas,  se  o  interesse  da  humanidade  se  sobrepõe  ao  interesse  individual.  Tal
possibilidade abre uma perigosa brecha para a ditadura das máquinas, que elegeriam por si qual é o
bem maior, sendo-lhe permitido, inclusive, fazer o mal a um ser humano (indivíduo), caso entendam
que isso é melhor para a humanidade.
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Estas leis não são de facto leis, no sentido real da palavra, mas são diretivas que todos os aficionados e
investigadores na área da robótica implementam na criação e desenvolvimento de robôs.

1.2.3. ALGUMAS ENTIDADES E EVENTOS RELACIONADOS COM A ROBÓTICA

RoboCup® - http://www.robocup.org/

O  RoboCupTM é uma iniciativa internacional de pesquisa e educação, com o objetivo de promover a
inteligência artificial e a robótica em geral. Tendo como domínio preliminar um jogo de futebol, são
desenvolvidas tecnologias nas diversas áreas da robótica, para que uma equipa de robôs consiga vencer
a equipa campeã do mundo humana no ano 2050.  Este  evento realiza-se  todos os  anos num país
diferente.

S.P.R. - http://www.spr.ua.pt/site/

A Sociedade Portuguesa de Robótica é uma associação sem fins lucrativos cujo principal objetivo é o de
promover e estimular o ensino, a investigação científica, o desenvolvimento tecnológico e as aplicações
(indústria e serviços) na área da robótica.

F.N.R. - http://www.spr.ua.pt/fnr/

O Festival Nacional de Robótica teve a sua 1ª edição em 2001, e tem como objetivo a promoção da
Ciência  e  da Tecnologia  junto dos jovens dos ensinos básico,  secundário e superior,  bem como do
público em geral,  através de competições de robôs.  O Festival  decorre todos os anos numa cidade
distinta. Inclui ainda um Encontro Científico onde investigadores nacionais e estrangeiros, da área da
Robótica,  se  reúnem  para  apresentar  os  mais  recentes  resultados  da  sua  atividade.
Este  evento  tem tido  desde  o  seu  início  um enorme crescimento,  quer  em  número  de  equipas  e
participantes, quer em termos de público. O Festival Nacional de Robótica é, atualmente, uma iniciativa
da Sociedade Portuguesa de Robótica.

RoboParty® – http://www.roboparty.org/

A RoboParty® consiste num evento pedagógico que reúne equipas de 4 pessoas, durante 3 dias e duas
noites (traz o teu saco cama), para ensinar a construir robôs móveis autónomos, de uma forma simples,
divertida e com acompanhamento por pessoas qualificadas. Inicialmente, é dada uma curta formação
(para aprender a dar os primeiros passos em Eletrónica, programação de robôs, e construção mecânica),
depois é entregue um KIT robótico desenvolvido pela empresa SAR - Soluções de Automação e Robótica
e  pela  Universidade  do  Minho,  para  ser  montado  pelos  participantes  (Mecânica,  eletrónica,  e
programação) e que no final do evento pertence à equipa. Todas as equipas têm acompanhamento de
pessoas  com  conhecimento  para  ajudar  na  construção  e  programação  do  teu  robô.
Decorrem em paralelo outras atividades lúdicas  como desporto,  música,  internet,  jogos,  festas,  etc.
Cada  participante  traz  o  seu  saco  cama  e  fica  lá  durante  todo  o  evento.
A RoboParty® é idêntica a uma LANParty e também funciona 24h/24h mas tem um objetivo pedagógico
e educacional. São ainda dadas a conhecer as regras das competições nacionais e internacionais de
robótica mais importantes para que possas participar.

botnroll.com – http://www.botnroll.com/

A botnroll.com desenvolve produtos didáticos na área da robótica móvel educacional. Os seus produtos
são excelentes auxiliares educativos para todos os que gostariam de se iniciar no mundo da robótica. Se
é um professor, encontrará nos nossos produtos a ferramenta ideal para ensinar mecânica, eletrónica e
programação nas suas aulas.
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1.3. A ELETRÓNICA – DEFINIÇÕES

A Eletrónica é o ramo da ciência que estuda o uso de
circuitos  formados  por  componentes  elétricos  e
eletrónicos,  com o objetivo principal  de  transformar,
transmitir, processar e armazenar energia. 

É o ramo da Física que estuda a emissão e o efeito de
eletrões e o seu uso em dispositivos eletrónicos.

A eletrónica estuda essencialmente o fluxo de cargas

através de semicondutores (condutores não metálicos).

A eletrónica permite-nos manipular a energia, através da transmissão, armazenamento, distribuição ou
conversão. Permite ainda, através de sinais elétricos, adquirir, processar, converter, encaminhar, filtrar e
armazenar informação.

A engenharia eletrónica consiste na aplicação dos princípios da eletrónica em tecnologias de modo a
solucionar problemas práticos.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 9
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2. COMPONENTES DO BOT’N ROLL ONE A

Ao abrires o teu Bot´n Roll ONE A verifica que contém os seguintes componentes:

1- Duas rodas motrizes
2-Dois motores de corrente contínua
3-Bateria
4-Cabo USB para ligação ao computador
5-Componentes eletrónicos maiores
6-Componentes mecânicos e roda fixa
7-Carregador de bateria
8-Acessórios de ligação e fixação da bateria
9-Placa de acrílico
10-Placa de circuito impresso
11- Componentes eletrónicos mais pequenos

NOTA  IMPORTANTE:  Na  falta  de  algum  dos  componentes  deverás  contactar  imediatamente  o
fornecedor do kit para a sua substituição ou reposição do (s) componente (s) em falta.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 10
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3. BATERIA

Coloca a bateria a carregar usando o carregador fornecido antes de iniciares a montagem. Desta forma
terás a bateria pronta a usar quando necessitares de usar o robô. A bateria fornecida é de Ni-MH
(hidreto metálico de niquel), 12V de tensão nominal e 800mAh de capacidade nominal.

3.1. CARGA DA BATERIA

A bateria fornecida é de Ni-MH 12V 800mAh. Quando totalmente descarregada, carrega em oito horas a
100mAh. Nunca deverá ficar mais do que este tempo a carregar pois irá danificar-se. As baterias Ni-MH
devem fazer ciclos completos de carga e descarga. Deves evitar ao máximo pôr a carregar durante uns
minutos ou até mesmo uma hora ou duas, pois desta forma, estás a encurtar a sua capacidade e o seu
tempo de vida.

Tensão máxima: considera-se que a bateria está totalmente carregada quando a sua tensão está entre
14,5V a 15V.

Tensão mínima: considera-se que a bateria está totalmente descarregada quando a sua tensão é de
10V.

Corrente de carga: o carregador fornecido permite definir a corrente de carga da bateria. Recomenda-se
uma corrente de carga igual ou inferior a um décimo da capacidade nominal da bateria, ou seja, para
uma bateria de 800mAh, a corrente de carga será de 800 / 10 = 80mA.

Tempo de carga: o tempo de carga é dado pela capacidade da bateria multiplicada por um factor de 1,4
e dividido pela corrente de carga, ou seja: 800 x 1,4 / 80 = 14 horas. A bateria deve ser desconectada do
carregador no final do tempo estimado de carga.

Carga Rápida: é possível carregar a bateria com uma corrente superior à calculada acima, no entanto
este processo vai causar aquecimento na bateria e diminuir o seu tempo de vida útil. Este procedimento
poderá ser efectuado ocasionalmente mas é desaconselhado.

Ciclos de carga: deves evitar ao máximo carregar a bateria somente durante uns minutos ou até mesmo
uma hora ou duas. Desta forma estás a encurtar a sua capacidade e o seu tempo de vida. Fazer ciclos de
carga e descarga completos prolonga a longevidade da bateria.

Polaridade: verifica que ligas a bateria ao carregador com a polaridade (“+” “-“) correta!

3.2. CUIDADOS A TER COM A BATERIA

Antes de ligares a bateria ao robô certifica-te que o cabo de ligação está corretamente conectado no
robô, de forma a evitar curtos-circuitos na bateria.

Nunca provoques um curto-circuito nos terminais da bateria! Isto irá destruir a bateria e podes provocar
um incêndio.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 11
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4. MONTAGEM DO BOT’N ROLL ONE A

A montagem do Bot'n Roll ONE A deve ser feita em três fases: 

1 - Montagem mecânica.
2 - Montagem eletrónica.
3 - Ligações elétricas.

DICA: Coloca a bateria a carregar enquanto efetuas a montagem. Desta forma poderás ter a bateria
carregada no final da montagem. A bateria quando totalmente descarregada, carrega completamente
em oito horas e nunca deverá ficar mais do que este tempo a carregar pois irá danificar-se. 

NOTA  IMPORTANTE: Necessitas  de  algumas  ferramentas  não  incluídas  no  kit,  nomeadamente,
multímetro, chaves de cruz PH1 e PH2, alicate de pontas, ferro de soldar, fio de solda, aspirador de solda
e alicate de corte.

4.1. MONTAGEM MECÂNICA

Para a montagem mecânica é necessário motores, rodas, suportes de motor, hubs, parafusos e a placa
de acrílico.

Antes de iniciar a montagem, remove as películas
protetoras da placa de acrílico!

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 12
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4.1.1. MOTORES

 A fixação de cada motor é efetuada usando um suporte
de motor com duas porcas M3 embutidas, três parafusos
M3x6mm PH1, dois parafusos M3x12m PH1. 

Necessitas de uma chave sextavada de 1.5mm incluída
no saco de componentes mecânicos e de uma chave de
cruz PH1 (não fornecida).

Fixa o motor no suporte usando os três parafusos mais
pequenos M3x6mm PH1.

Usando a chave de cruz PH1, aperta os três parafusos
convenientemente.

Fixa o suporte com o motor à placa de acrílico usando os
dois  parafusos  mais  compridos  M3x12mm  PH1  e  as
porcas M3 embutidas no suporte. 

A  placa  de  acrílico  possui  um  orifício  destinado  à
passagem dos fios dos motores para posterior ligação à
placa eletrónica do robô. Introduz os fios no orifício de
acordo com a imagem.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 13

Fig. 8: Fixação da peça em L aos motores

Fig. 7: Material necessário para a
colocação dos motores

Fig. 10: Passagem dos fios dos motores pela
placa de acrílico

Fig. 9: Fixação dos motores à placa de acrílico
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4.1.2. RODAS DE TRAÇÃO

O Bot’n Roll ONE A move-se usando duas rodas de tração
que estão ligadas aos motores. São feitas de plástico e
têm um revestimento em borracha.

Para  a  colocação  de  cada  roda  é  necessário  usar  um
“hub” de acoplamento, um perno M3x3mm sextavado e
um parafuso M4x6mm PH2.

O veio do motor possui uma zona que não é redonda!
Esta zona serve para encravar mecanicamente o parafuso
de um hub e evitar que ele rode sobre o veio. Asseguras
assim que toda a energia do motor é transmitida para as
rodas!

Encaixa  o  hub no  veio  do  motor  e  enrosca  o  perno
sextavado  contra  a  parte  lisa  do veio  usando  a  chave
sextavada de 1.5mm.

Introduz a roda no hub sextavado fazendo pressão para
que fique bem inserido na roda.

Fixa a roda ao  hub usando o parafuso M4x6mm PH2 e
aperta-o convenientemente!

NOTA  IMPORTANTE: Verifica  que  não  existem  folgas
entre  a  roda  e  o  motor  pois  isso  influenciará  o
movimento do robô!
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Fig. 11: Material para fixar as rodas de tração

Fig. 12: Procedimento para fixar
as rodas de tração
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4.1.3. RODA FIXA

A roda fixa serve de apoio ao Bot’n Roll ONE A e permite
ajustar a inclinação do robô para que fique a teu gosto!
Para isso, terás de regular em altura a traseira do robô.

Para  a  colocação  da  roda  fixa  usam-se  dois  parafusos
M5x20mm PH2 e seis porcas M5.

Insere  os  parafusos na placa de acrílico  e  coloca duas

porcas M5 em cada parafuso. 

Coloca a  roda fixa  inserindo os  parafusos nos  orifícios
correspondentes  e  rosca  a  última  porca  M5  em  cada

parafuso. 

Aperta as porcas  M5 de forma a ajustares a altura do
robô a teu gosto. 

Verifica  que não  existem folgas  e  que a  roda fixa  fica
corretamente alinhada com as rodas de tração pois este
pormenor influencia o movimento do robô.

Terminaste assim a montagem mecânica do teu Bot’n Roll ONE A! Parabéns! 

Podes avançar para a montagem eletrónica.
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Fig. 13: Material para colocar a roda fixa

Fig. 14: Montagem da roda fixa e ajuste em
altura da traseira do robô
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4.2. MONTAGEM ELETRÓNICA

Para a montagem eletrónica necessitas do seguinte material que
não é fornecido com o robô:

 Ferro de soldar
 Estanho
 Aspirador de solda
 Alicate de corte

NOTA IMPORTANTE:  Nesta fase, todos os componentes eletrónicos são soldados na Placa de Circuito
Impresso. É aconselhado que soldes os componentes pela ordem indicada no manual, pois facilita o
processo de soldadura. Soldaduras mal efetuadas poderão causar a destruição de componentes e da
placa de circuito de impresso, por isso mesmo, antes de iniciares a soldadura dos componentes deverás
ler o “Minicurso de Soldadura” presente na documentação do teu Bot’n Roll ONE A. 

4.2.1. PLACA DE CIRCUITO IMPRESSO (PCB)

A  Placa  de  Circuito  Impresso  (PCB)  possui
orifícios onde são introduzidos os componentes
eletrónicos.

A  serigrafia  (descrição  dos  componentes  em
branco) identifica onde inserir cada componente
e a sua orientação na Placa de Circuito Impresso.

A  Placa  de  Circuito  Impresso  atua  como base
para a  fixação  dos  componentes  eletrónicos  e
contém todas as ligações entre os mesmos de
acordo com o esquema elétrico do robô.

Deves colocar os componentes do lado da serigrafia (letras brancas) e soldá-los à placa do lado oposto.
Não é  necessário  soldar  os  componentes  do lado da serigrafia pois  os  furos  são metalizados,  logo
permitem a passagem de corrente de um lado da placa para o outro.
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Fig. 15: Material para a montagem eletrónica

Fig. 16: Placa de circuito impresso (PCB)
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4.2.2. RESISTÊNCIAS

Resistência  elétrica  é  o  nome  que  se  dá  a  um
elemento  que  se  oponha  à  passagem  da  corrente
elétrica (contínua ou alternada).

Normalmente  as  resistências  representam-se  pela
letra R e a sua unidade de medida é o Ohm (Ω).

O seu valor nominal é representado por faixas coloridas (código de cores), que obedecem ao seguinte
critério: partindo da extremidade, as duas primeiras cores formam um número com dois algarismos; a
terceira cor é o multiplicador, corresponde ao expoente da potência de 10 que multiplica o número
inicial; a quarta cor corresponde à tolerância, em percentagem.

Cor 1ª Faixa 2ª Faixa 3ª Faixa 4ª Faixa
1º Número direto 2º Número direto Fator multiplicador Tolerância %

Prata 0.01 +/- 10
Ouro 0.1 +/- 5
Preto 0 0 X 1 Sem cor +/- 20
Castanho 1 1 X 10 Prateado +/- 1
Vermelh 2 2 X 100 Dourado +/- 2
Laranja 3 3 X 1,000 +/- 3
Amarelo 4 4 X 10,000 +/- 4
Verde 5 5 X 100,000
Azul 6 6 X 1,000,000
Violeta 7 7
Cinzento 8 8 X 0.1
Branco 9 9 X 0.01

Tabela 1: Código de cores das resistências

Exemplo: Qual o valor da resistência da imagem?

As duas primeiras cores: amarelo (4) e violeta (7) formam o número
47. A terceira cor, laranja (3), corresponde ao expoente da potência
de dez: 103, ou seja, multiplica-se por 1000, a quarta cor, prata (10%),
indica a tolerância. Assim, a resistência elétrica é:

R = 47000Ω com tolerância de 10% ou R = (47 000 Ω ± 4700Ω)
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Fig. 17: Resistência - faixas do código de cores

Fig. 18: Imagem de exemplo
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Tomando como referência a tabela ao lado, solda as resistências nos locais correspondentes na placa de
circuito impresso:

Solda as resistências de valor de 1KΩ ±5% 
(Cores:  Castanho,  Preto,  Vermelho e  Dourado) em  R1, R6,  R7,  R8,  R13,
R14, R16, R17, R18, R19, R20, R22 e R23; 

Solda as resistências de valor de 10KΩ ±5% 
(Cores: Castanho, Preto, Laranja e Dourado) em R3, R4, R5, R11 e R12;

Solda as resistências de 120Ω ±5% 
(Cores: Castanho, Vermelho, Castanho e Dourado) em R15, R24 e R25;

Solda a resistência de 1MΩ ±5% 
(Cores: Castanho, Preto, Verde e Dourado) em R21;

Solda as resistências de 3,3KΩ ±5% 
(Cores: Laranja, Laranja, Vermelho e Dourado) em R2, R9 e R10.

Dica: Coloca  primeiro  todas  as
resistências  nos  respetivos  locais
dobrando  ligeiramente  os  terminais  de
cada resistência. 

Para soldar, aperta as resistências contra
a  mesa  de  trabalho  antes  de  aplicar  a
solda. 

Depois  de soldares  as  resistências  corta
os terminais  o  mais  curto  possível  para
evitar curto-circuitos.
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Fig. 20: Resistências na placa de circuito impresso

Fig. 19: Resistências do Bot'n Roll ONE A

Descrição Componente
R1 1 KΩ
R2 3,3 KΩ
R3 10 KΩ
R4 10 KΩ
R5 10 KΩ
R6 1 KΩ
R7 1 KΩ
R8 1 KΩ
R9 3,3 KΩ
R10 3,3 KΩ
R11 10 KΩ
R12 10 KΩ
R13 1 KΩ
R14 1 KΩ
R15 120 Ω
R16 1 KΩ
R17 1 KΩ
R18 1 KΩ
R19 1 KΩ
R20 1 KΩ
R21 1 MΩ
R22 1 KΩ
R23 1 KΩ
R24 120 Ω
R25 120 Ω
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4.2.3. CRISTAL OSCILADOR

Um Cristal  Oscilador é um circuito eletrónico,  que usa as  propriedades
ressonadoras de um cristal piezoelétrico, para criar um sinal elétrico com
uma frequência muito precisa. O Bot’n Roll ONE A usa um cristal oscilador
de quartzo de 16MHz que faz com que o IC ATmega328 funcione a uma
frequência de 16MHz. A utilização de um cristal faz do Bot’n Roll ONE A
uma máquina bastante precisa para a medição de tempo, á semelhança

dos relógios, que também usam cristais de quartzo. 

O  Cristal  Oscilador  é  colocado  na  placa  de  circuito
impresso no identificador “XTAL” da serigrafia. 
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Fig. 21: Cristal Oscilador

Fig. 22: Cristal Oscilador na placa

Descrição Componente
XTAL Cristal 16MHz
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4.2.4. DÍODOS

O  díodo  convencional  é  composto  por  dois  blocos  de  material
semicondutor, um do tipo N, dopado com iões negativos (-), e outro do
tipo P dopado com iões positivos (+).

O  díodo  tem  como  característica  mais  importante,  permitir  que  a
corrente circule apenas num sentido (sentido direto). 

Para indicar a polaridade, o díodo tem uma marca que aponta para a
extremidade correspondente ao cátodo. O sentido positivo da corrente
elétrica flui do ânodo (+) para o cátodo (-).

O  díodo  Zener diferencia-se  do  díodo  convencional  pelo  facto  de
permitir a condução nos dois sentidos (direto e inverso), em situações
controladas, sem se danificar. O díodo Zener tem associada uma tensão
reversa que se mantém constante numa situação em que a corrente flui
no sentido inverso. Isto  permite  que seja  usado no Bot’n  Roll  ONE A
como  um  elemento  de  proteção  no  circuito  de  medição  da  bateria.
Funciona  como um limitador  de tensão.  Aos  seus  terminais  a  tensão
nunca subirá acima dos 5,1V e assim o PIC18F45K22 não se danificará se
a  bateria  tiver,  acidentalmente,  valores  de  tensão  excessivamente
elevados.

A placa possui díodos com duas referências:

1N4934,  que  é  usado  no  acionamento  dos  motores  e  na
proteção do circuito de alimentação do robô;

Zener 5v1 que é usado na medição da tensão da bateria.

Os díodos têm polaridade, ou seja, só funcionam corretamente
no  circuito  se  forem  colocados  na  orientação  correta!  Cada
díodo  possui  uma marca  que  tem  de  coincidir  com a  marca
representada na serigrafia da placa (Fig. 26). 

A  referência  do  díodo  encontra-se  impressa  no  próprio
componente.

Coloca o díodo Zener 5V1 em Z1.

Coloca os díodos FR203 nas posições:D1,  D2, D3, D4, D5, D6,
D7, D8, D9, D10, D11 e D12.
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Fig. 26: Colocação dos díodos

Fig. 23: Díodo

Fig. 24: Díodo Zener

Fig. 25: Díodos do robô

Descrição Componente
D1 1N4934
D2 1N4934
D3 1N4934
D4 1N4934
D5 1N4934
D6 1N4934
D7 1N4934
D8 1N4934
D9 1N4934
D10 1N4934
D11 1N4934
D12 1N4934
Z1 Zener 5v1
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4.2.5. POTENCIÓMETROS

Um potenciómetro é uma resistência variável, ou seja, o seu valor pode ser ajustado.
Desta forma consegues controlar a intensidade da corrente que flui num determinado
circuito. No Bot’n Roll ONE A, os potenciómetros permitem que ajustes a distância do
sensor de obstáculos, o contraste e o brilho do display LCD.

 A  placa  de  circuito  impresso  possui  quatro
potenciómetros com o valor de 10KΩ.

O  seu  valor  encontra-se  escrito  na  parte  lateral  do
potenciómetro, como exemplificado na Fig. 28.

A inscrição P 103 corresponde a 10 000Ω, isto é, 10 KΩ.

O potenciómetro  IRD1  regula a distância da deteção de
obstáculos do lado esquerdo.

O potenciómetro  IRD2  regula a distância da deteção de
obstáculos do lado direito.

O potenciómetro BR regula o brilho do display LCD.

O potenciómetro CT regula o contraste do display LCD.
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Fig. 28: Potenciómetros

Fig. 27: Potenciómetro

Descrição Componente
IRD1 Potenciómetro10KΩ
IRD2 Potenciómetro10KΩ
BR Potenciómetro 10KΩ
CT Potenciómetro 10KΩ

http://es.wikipedia.org/wiki/Archivo:Potentiometer_symbol_Europe.svg
http://es.wikipedia.org/wiki/Archivo:Potentiometer_symbol.svg
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4.2.6. LEDS DE CÔR

Um LED –  Díodo Emissor  de Luz,  é constituído por  uma junção PN de
material semicondutor e por dois terminais, o Ânodo (A, terminal positivo)
e o Cátodo (K, terminal negativo).

A cor da luz emitida pelo LED depende do material semicondutor que o
constitui.

Tal como o díodo, o LED tem polaridade. O chanfro identifica o cátodo (-) e
está associado ao perno mais curto.

Atenção! Nunca deverás olhar diretamente para a luz emitida por um
LED. A uma distância curta,  a  luz é suficientemente forte para ferir  a
retina e os danos são permanentes.

Os díodos emissores de luz (LED’s) indicam o estado do teu
Bot’n Roll ONE A.

O LED verde aceso indica que o robô está ligado. 

Os LED’s amarelos são LED’s de  “debug” e são controlados
pelo teu programa.

Os LED's vermelhos estão associados ao circuito de deteção
de obstáculos.

Coloca o LED verde na posição assinalada por ON.

Os LED's amarelos em L e LED.

Os LED’s vermelhos em IRS1 e IRS2.

NOTA IMPORTANTE:  Não te esqueças  que os  LED’s  têm polaridade! Deves inserir  o  perno mais
comprido de cada LED onde está assinalado o sinal “+” na placa.
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Fig. 30: LED’s

Fig. 29: LED

Descrição Componente
ON LED Verde
L LED Amarelo
LED LED Amarelo
IRS1 LED Vermelho
IRS2 LED Vermelho
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4.2.7. SUPORTES DOS CIRCUITOS INTEGRADOS

Os  suportes  dos  circuitos  integrados  permitem  uma  fácil
substituição  dos  circuitos  integrados  no  caso  de  estes  se
danificarem.  Nunca  deverás  soldar  os  circuitos  integrados
diretamente na placa de circuito impresso!

Existem  dois  suportes  que  servem  de  base  para  os
circuitos integrados  ATmega328 e PIC18F45K22. Estes
suportes têm 28 e 40 pinos respetivamente. 

Cada  suporte  tem uma  ranhura  num  dos  topos  que
deverá coincidir com a serigrafia na placa. A colocação
dos  suportes  deve  respeitar  estas  ranhuras  pois  são
muito  importantes  na  colocação  dos  circuitos
integrados.  Os  circuitos  integrados  também  as
possuem.  Se  colocares  um  circuito  integrado  na
orientação  errada  poderás  danificá-lo
irremediavelmente!

Os suportes devem ser soldados em U1 e U2.

NOTA  IMPORTANTE: Os  circuitos  integrados  ATmega328  e  PIC18F45K22  serão  inseridos
posteriormente nos respetivos suportes. Só deverão ser inseridos no passo 3.3.4 depois de efetuares
as ligações elétricas.
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Fig. 31: Suportes dos circuitos integrados

Descrição Componente
U1 Suporte 28 pinos
U2 Suporte 40 pinos
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4.2.8. EMISSORES DE INFRAVERMELHOS

Os Emissores de Infravermelhos são LED’s que emitem luz
infravermelha. Esta luz não é visível pelos seres humanos,
no  entanto  causa  danos  na  retina  tal  como  nos  LED´s
convencionais!

Usando  uma  câmara  de  vídeo,  de  um  telemóvel  por
exemplo, conseguirás verificar se os LED´s estão ou não a
emitir.

Os emissores de infravermelhos são usados no circuito
de deteção de obstáculos. São eles que emitem a luz que
será refletida pelos obstáculos.

Coloca os emissores de infravermelhos nas posições IRE1
e IRE2 virados para o exterior da placa. 

4.2.9. BOTÕES DE PRESSÃO

Um  botão  de  pressão  coloca  um  sinal  elétrico  no  circuito
enquanto este estiver a ser pressionado.

Quatro botões de pressão permitem que interajas com o
robô. Podes por exemplo navegar  em menus e  alterar
parâmetros  do  teu  programa  de  forma  rápida  e  sem
estar ligado ao computador.

Os  botões  de  pressão  PB1,  PB2 e  PB3 "Push  Button"
foram pensados para interação e navegação em menus

apresentados no display LCD. 

O botão Reset serve para reiniciar o Arduino.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 24

Fig. 32: LED's emissores de infravermelhos

Fig. 33: Botões de pressão

Descrição Componente
IRE1 Emissor Infravermelho
IRE2 Emissor Infravermelho

Descrição Componente
PB1 Botão de pressão
PB2 Botão de pressão
PB3 Botão de pressão
Reset Botão de pressão
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4.2.10. INTERRUPTOR GERAL

Um interruptor é um dispositivo que permite interromper o
fornecimento de energia (corrente elétrica) a um circuito.

O interruptor geral permite ligar e desligar o robô. 

Deverá ser soldado em SW "Switch".

O Bot'n Roll ONE A ficará ligado quando deslizares o
interruptor para a frente robô. Desliga se deslizares o
interruptor para trás!

4.2.11. BUZZER

O  buzzer é um componente transdutor que transforma pulsos
elétricos em som. 

O  buzzer pode ser usado para criares melodias ou sons
de aviso, por exemplo, para indicação de que o nível da
bateria está a ficar demasiado baixo.
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Fig. 35: Buzzer

Fig. 34: Interruptor Geral

Descrição Componente
SW Interruptor Geral

Descrição Componente
Buzzer Buzzer
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4.2.12. CONDENSADORES CERÂMICOS

O condensador é um componente que armazena energia entre duas placas
condutoras  (E=1/2CV2).  Serve  para  estabilizar  a  energia  no  circuito  do
robô.

A capacidade elétrica (C) relaciona a carga armazenada com a tensão aos
seus  terminais  (C=Q/V).  O  condensador  é  composto  por  duas  placas
condutoras que são separadas por um isolante ou dielétrico. 

Existem  condensadores  monolíticos  (sem  polaridade  –  à  esquerda)  e
eletrolíticos (com polaridade – à direita).

O Bot’n Roll ONE A contém condensadores cerâmicos de
dois valores distintos: 22pF e 100nF.

O  condensador  de  22pF  tem  a  inscrição  22  e  o
condensador de 100nF tem escrito 104K.

Coloca os condensadores de 100nF em C1, C2, C3, C7, C8,
C11 e C12.

Coloca  os  condensadores  de  22pF  em  C9 e  C10.
Condensadores  de  33pF  podem  ser  usados  como
alternativa!
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Fig. 37: Condensadores cerâmicos

Fig. 36: Condensador

Fig. 38: Colocação dos condensadores

Descrição Componente Inscrição
C1 100nF 104K
C2 100nf 104K
C3 100nF 104K
C7 100nF 104K
C8 100nF 104K
C9 22pF 22
C10 22pF 22
C11 100nF 104K
C12 100nF 104K
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4.2.13. TRANSISTORES BIPOLARES

Um transístor é um dispositivo semicondutor usado para amplificar e comutar sinais elétricos. No Bot'n
Roll ONE A é usado no circuito de deteção de obstáculos para aumentar a potência da luz emitida pelos
LED's emissores de infravermelhos.

É constituído por três camadas de material semicondutor do
tipo P e N e possui três terminais:  Emissor, Base e Coletor. A
disposição três das camadas P e N define se o transístor é PNP
ou NPN. 

Quando usado como amplificador, a corrente que flui entre a
base e o emissor (entrada) é amplificada e manifesta-se entre
o coletor e o emissor (saída). Quando o transístor é usado como comutador, o sinal de entrada da
base ativa ou desativa o sinal de saída. Dependendo da configuração da ligação do transístor, o sinal
amplificado ou comutado na saída pode ser invertido ou não em relação ao sinal de entrada.

Os dois transístores PNP BC557 deverão ser colocados em Q1
e Q2.

Estes componentes estão presentes no circuito
emissor de infravermelhos, funcionando como
comutadores,  permitindo  ao  PIC18F45K22
apagar  e  acender  os  LED's  emissores  de
infravermelhos  com  elevada  potência.  Desta
forma os  obstáculos  podem ser  detetados  a
grandes distâncias!

Os transístores têm polaridade! Só funcionam se forem colocados corretamente no circuito.

Deves alinhar a parte reta do transístor com a parte reta da serigrafia na placa.
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Fig. 40: Transístor PNP BC557B

Fig. 39: Transístor Bipolar NPN

Descrição Componente
Q1 Transístor BC557
Q2 Transístor BC557

http://en.wikipedia.org/wiki/File:NPN_BJT_(Planar)_Cross-section.svg
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4.2.14. JUMPERS

Um jumper é um conetor que permite configurar o robô a
nível  elétrico,  direcionando  a  corrente  elétrica  para
determinadas zonas do circuito.

O Bot'n Roll ONE A possui um jumper de duas posições e dois
jumpers de uma posição.

O  jumper de  duas  posições  SPOW "Servo  Power"  permite
selecionar  se  os  servos  são  alimentados  pelo  regulador  de
tensão geral  7805 ou pelo regulador de tensão dedicado aos
servos PWR.

O jumper BUZ liga ou desliga o buzzer ao pino I/O 9 do Arduino.

O jumper SSP quando ligado, permite que a comunicação entre
o Arduino e o PIC se processe usando o pino I/O 2 do Arduino
como "Slave Select" do barramento de comunicação SPI.
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Fig. 41: Jumpers

Descrição Componente
SPOW Jumper de 2 posições
BUZ Jumper de 1 posição
SSP Jumper de 1 posição
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4.2.15. CONETORES ARDUINO

O conjunto de cinco conectores permite a ligação de
“shields” compatíveis com Arduino, como o  shield de
comunicação sem fios XBee, por exemplo. 

Solda cada um dos cinco conetores nas ligações com o
mesmo número de pinos do conector. Verifica que ficam
bem alinhados e encostados à placa de circuito impresso!

Cada  um  dos  5  conetores  Arduino  tem  uma  função
específica:

O conector  VIN-IOREF é o  Conetor de Alimentação do
Arduino. Tens aqui todas as tensões do circuito do robô:
5V,  3.3V,  VIN (tensão da bateria)  e  GND (0V).  O  pino
RESET está ligado ao botão Reset do Arduino e o IOREF
está reservado para shields que aparecerão futuramente.

No  conector  A0-A5 estão  localizadas  as  entradas
analógicas do Conversor Analógico para Digital (ADC) do
Arduino.  Aqui  poderás  ligar  sensores  analógicos  que
variem  o  sinal  de  saída  entre  0V  e  5V.  Com  algumas
linhas de código obténs o valor digital correspondente.
Se usares comunicação I2C não poderás usar os pinos A4
e  A5 como entradas para o ADC pois ficam reservadas
para a comunicação I2C. 

Junto ao conetor A0-A5 encontras um grupo de ligações triplas que possuem a mesma identificação A0-
A5. Aqui podes ligar sensores analógicos que necessitem também de alimentação 0V e 5V. Neste grupo
de conetores os pinos "s" correspondem às entradas analógicas, "-" corresponde à tensão de 0V e "+"
corresponde à tensão de 5V.

Nos conetores 0-7 e 8-SCL estão as entradas e saídas digitais do Arduino (I/O) e cada um destes pinos
pode ser configurado no software como sendo uma entrada ou uma saída digital.  Em cada uma das
saídas  0 a  13 consegues colocar um sinal  de 0V ou 5V que correspondem aos estados  Low e  High
respetivamente. Nos pinos com o símbolo "~", por exemplo ~3 consegues que a saída seja PWM e aqui
poderás controlar servo-motores, como os da garra por exemplo. Configurados como entradas digitais,
para ligares sensores digitais por exemplo, em cada um destes pinos consegues verificar se tens 5V ou
0V. Os pinos SCL e SDA são para a comunicação I2C e correspondem aos pinos A4 e A5 do conector A0-
A5. O pino AREF só deverá ser usado no caso de necessitares de uma tensão de referência externa para
as conversões do ADC, mas esta tensão só poderá variar entre 0V e 5V!

Junto  aos  conetores  0-7 e  8-SCL encontras  um  grupo  de  ligações  triplas  que  possuem  a  mesma
identificação  0-7 e  8-SCL.  Aqui podes ligar sensores e atuadores digitais que necessitem também de
alimentação  0V e  5V.  Neste  grupo de conetores  os  pinos "s"  correspondem aos  pinos  digitais,  "-"
corresponde à tensão de 0V e "+" corresponde à tensão de 5V.
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Fig. 42: Conetores Arduino

Descrição Componente
ICSP Conector 2x3 macho
A0-A5 Conector 1x6 fêmea
VIN-IOREF Conector 1x8 fêmea
0-7 Conector 1x8 fêmea
8-SCL Conector 1x10 fêmea



Manual de montagem Bot’n Roll ONE A

O conetor ICSP tem como funções principais a comunicação SPI com shields e a programação ICSP (In
Circuit Serial Programming) do bootloader do Arduino.

4.2.16. CONETORES DE POTÊNCIA

 Os conetores de potência permitem ligar a bateria e os
motores  à  placa  de  circuito  impresso.  Fixam  os  fios
condutores através de parafusos.

Une os conetores usando as ranhuras que possuem para
o efeito de forma a obteres um único conector de seis
ligações. 

Encaixa-o e solda todos os terminais no PCB.

MotorL é a ligação para o motor esquerdo, MotorR para
motor direito e Bat para o conector da bateria.
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Fig. 43: Conectores de potência e sua colocação

Descrição Componente
MotorL Conector  do  motor

esquerdo
Bat Conector da bateria
MotorR Conector do motor direito
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4.2.17. FUSÍVEL E SUPORTE DE FUSÍVEL

Um fusível é um dispositivo de proteção composto por um
condutor metálico que funde assim que a corrente que flui
através dele excede a corrente especificada no componente.

Para proteção contra curto-circuitos coloca-se um fusível
lento  de  4A  com  o  respetivo  suporte.  Se  a  corrente
fornecida pela bateria exceder os 4A, o fusível queimará.

Coloca o  fusivel  lento de 4A na  tampa do suporte  de
fusível.

O  suporte  de  fusível  deve  ser  inserido  e
soldado  na  placa  de  circuito  impresso  em
“F1”. 

Insere a tampa com o fusível no suporte. 

4.2.18. CONDENSADORES ELECTROLÍTICOS

Os condensadores eletrolíticos têm terminais polarizados! Como
tal, ao serem colocados na placa de circuito impresso, tem que se
respeitar a sua polaridade.

Devem ser colocados em  C4  e C5  com o terminal mais
comprido inserido no local  identificado com o símbolo

“+” na serigrafia da placa. 

A capacidade destes condensadores é de 100µF.
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Fig. 44: Colocação do fusível no circuito

Fig. 45: Condensadores eletrolíticos

Descrição Componente
F1 Suporte fusível

Descrição Componente
C4 100µF
C5 100µF
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4.2.19. CONETORES I2C

Estes conetores permitem que ligues ao robô, componentes
comunicam  por  I2C,  por  exemplo:  bussolas,  sonares,
acelerómetros, sensores de temperatura e humidade, etc.

Coloca os conetores em I2C1 e I2C2 para que o traço

na serigrafia coincida com a parte plástica do conetor.

4.2.20. CONVERSOR USB-SÉRIE

O conversor USB – Série (RS232) é o dispositivo que permite
programar o robô através de uma porta USB do computador.

Este  dispositivo  é  colocado  na  placa  onde  a  serigrafia
indica ”USB”.
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Fig. 47: Conversor USB-Série

Fig. 46: Conetores I2C

Descrição Componente
I2C1 Conector KK 1x4 macho
I2C2 Conector KK 1x4 macho

Descrição Componente
USB Conversor USB
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4.2.21. DISSIPADOR DE ENERGIA TÉRMICA

Um dissipador térmico é um objeto de metal que permite baixar
a temperatura de funcionamento de um componente. Evita que
o componente se danifique devido a temperatura excessiva e
aumenta o seu tempo de vida. 

Fixa o dissipador ao LM7805 usando o parafuso e a porca
fornecidos  para  o  efeito.  Encosta  a  superfície  lisa  do
dissipador ao metal, "nas costas" do LM7805.

4.2.22. REGULADORES DE TENSÃO

Os componentes LM7805 e LD33CV são reguladores de tensão
lineares que fornecem tensões específicas para a alimentação
do circuito do robô.

O 7805 serve como fonte de alimentação para dispositivos que
trabalham com tensão de 5 Volts  enquanto o  LD33 alimenta
dispositivos que funcionam com 3,3 Volts.

De acordo com a serigrafia, coloca o LM33CV onde está indicado
“LD33” e o LM7805 onde está indicado “7805”.

Deves soldar o LM7805 com o dissipador de energia térmica já
colocado!

Respeita  a  orientação  dos  componentes!  Nota  que  o  duplo
traço  da  serigrafia  corresponde  ao  dissipador  metálico  do

componente. 
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Fig. 49: Reguladores de tensão LD33 e 7805

Fig. 48: Dissipador de energia térmica

Descrição Componente
7805 LM7805
LD33 LD33CV

Descrição Componente
7805 LM7805
LD33 LD33CV
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4.2.23. PONTE H L298

O  L298N  corresponde  a  uma  dupla  ponte  H  para  controlar,
independentemente,  cada motor  do robô,  permitindo que se
varie a velocidade e a direção. 

Este componente permite uma corrente máxima de 2A em cada
ponte  H  para  funcionamento  contínuo.  Por  breves  instantes
(durante 100us) permite debitar 3A para cada motor.

Coloca o componente L298N em “U3”. 

4.2.24. RECETORES DE INFRAVERMELHOS

Os recetores de infravermelhos são sensores que detetam a luz
infravermelha  refletida  pelos  obstáculos.  Esta  luz  é  emitida
pelos  LED's  de  infravermelhos  como  um  sinal  modulado  a
56KHz,  ou  seja,  cada  LED  acende  e  apaga  56.000  vezes  por
segundo! Se os LED´s não emitirem com estas características os
sensores não vão detetar os obstáculos.

Dois  recetores  de  infravermelhos  são  colocados  na
parte  inferior  da  placa,  ao  contrário  de  todos  os
componentes que já soldaste.

Insere  os  recetores  VISHAY  TSSP4056  por  baixo  da
placa em  IRR1 "Infra-Red Receiver1" e  IRR2, com os
sensores  virados  para  o  exterior  como indicado  na
figura.

Estes  recetores  deverão  ser  soldados  da  parte  de
cima da placa, ao contrário do que fizeste até agora. 
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Fig. 50: Circuito integrado L298N

Fig. 51 Recetores de infravermelhos

Descrição Componente
U3 L298N

Descrição Componente
IRR1  VISHAY TSSP4056
IRR2  VISHAY TSSP4056
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4.2.25. LCD

O LCD é um dispositivo que permite ao robô interagir  com o
utilizador  através  mensagens  escritas,  como  por  exemplo,
estados do programa ou o valor de variáveis. 

O LCD do Bot'n Roll ONE A é alfanumérico, de 2 linhas com 16
caracteres por linha. Tem contraste e brilho ajustáveis.

Para suporte do LCD são fornecidos um conector de 16
pinos,  dois parafusos M3x10  PH1, dois espaçadores de
nylon e duas porcas M3.

Para fixares o LCD terás que remover o pedaço de placa 
que preenche o recetáculo. Usa uma lima para alisar o 
recetáculo, se necessário, de modo a que o LCD entre 
sem esforço.

O LCD entra no recetáculo pela parte inferior da placa do
Bot’n Roll ONE A. Antes de o colocares insere o conetor
de  16  pinos  nos  orifícios  do  LCD  com  os  pinos  mais
compridos virados para baixo.

Insere o LCD na placa do robô e coloca os dois conjuntos 
parafuso, espaçador de nylon e porca, como indicado na 
figura e fixa o LCD à placa de circuito impresso do robô 
apertando os parafusos.

Verifica que o conetor de 16 pinos ficou "entalado" entre
o LCD e a placa do Bot'n Roll ONE A com os pinos dentro 
dos furos da ligação "LCD" na placa do robô.

Confirma que o LCD está bem alinhado e solda os 16 
pinos do conector na placa do Bot’n Roll ONE A. De 
seguida solda os 16 pinos no LCD, por baixo.

O pedaço de PCB removido da placa foi pensado para ser 
usado como um porta-chaves exclusivo e distintivo!
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Fig. 52: Colocação do LCD

Descrição Componente
LCD Conector 1x16
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4.2.26. PROTECÇÃO DO CONVERSOR USB-SÉRIE

O conversor USB-Série é um componente que está  sujeito  a
constantes tensões físicas resultantes da introdução e remoção
do cabo USB. Para o proteger foi desenvolvido um invólucro
em plástico PLA,  impresso em 3D que “abraça”  o conversor
USB-Série e permite manter a integridade da sua estrutura.

Coloca  a  proteção  plástica  no  conversor  USB-Série
deixando visível a ligação para o cabo USB. Verifica que
os dois furos na base da protecção plástica coincidem
com os furos na placa do robô.

Insere os dois parafusos M3x6mm nos orifícios e aperta-
os,  usando uma chave PH1, roscando-os na protecção
plástica.  Rosca  os  parafusos  até  a  base  da  protecção
plástica ficar em contacto com na placa do robô, mas
não apertes demasiado pois podes moer o plástico!

Verifica que os parafusos não estejam em contacto com
as soldas da placa, pois podem causar curto-cicuitos!

O conversor USB-Série está agora fisicamente protegido
com muita robustez, para uma utilização diária!
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Fig. 53: Colocação da proteção do conversor
USB-Série
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4.3. LIGAÇÕES ELÉCTRICAS E TESTES

4.3.1. LIGAÇÃO DO CONECTOR DA BATERIA

NOTA MUITO IMPORTANTE: 

Um curto-circuito da bateria poderá incendiá-la!

Não ligues nunca a bateria ao robô antes de efetuares
todas as ligações! 

Antes  de  desapertares  o  cabo  da  bateria  do  conector
"Bat", verifica que a bateria não está conectada ao cabo! 

O conector da bateria será ligado em "Bat". O condutor
vermelho deverá ser ligado onde a serigrafia indica “+” e
o  condutor  preto  onde  é  indicado  ” –“.  Aqui  sim,  a
polaridade é importante!

A passagem dos cabos da parte inferior do robô para a
placa de circuito impresso é efetuada pelo orifício central
presente na placa e na base acrílico.

4.3.2. TESTE ELÉTRICO À MONTAGEM EFETUADA

Liga agora a bateria carregada ao robô e verifica que o
LED ON acende e apaga quando comutas o interruptor. 

Verifica com um voltímetro que as tensões 5V, 3.3V e VIN
(tensão  da  bateria)  estão  presentes  no  conector  de
alimentação  do  Arduino  (VIN-IOREF).  Deverás  sempre
medir em relação a GND que corresponde a 0V.

Se  alguma  das  situações  anteriores  não  se  verificar,
significa que existem problemas na montagem da placa.
Deverás solucioná-los antes passares ao passo seguinte.
Na  tabela  abaixo  apresentam-se  algumas  dicas  para
tentares resolver o problema:
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Fig. 54: Ligação do conector da bateria

Fig.55: LED ON
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Possível Causa / Verificação Solução
A bateria não está corretamente inserida
no conector da bateria.

Verifica a ligação do conector da bateria e assegura-te de
que a patilha do conector fica travada.

Os fios da bateria não estão devidamente
inseridos na placa do Bot’n Roll ONE A.

Verifica  que  os  fios  do  conector  da  bateria  estão
devidamente apertados no conector "Bat".

O fusível não está inserido no circuito. Insere  o  fusível  como  indicado  na  alínea  3.2.17  deste
manual.

O fusível fundiu. O mais provável é que exista um curto-circuito na placa.
Verifica  as  soldas,  identifica  e  remove  o  curto-circuito
antes de introduzires um novo fusível.

O  fusível  não  está  fundido  mas  o  LED
verde ON não acende ou as tensões não
estão  todas  presentes  no  conector  de
alimentação do Arduino.

Neste caso poderá ainda existir um curto-circuito mas a
corrente não é suficiente para fundir o fusível. Verifica a
temperatura dos reguladores de tensão 7805 e LD33.

A  temperatura  de  um,  ou  dos  dois
reguladores de tensão está elevada.

Há  grande  probabilidade  de  existir  um  curto-circuito.
Verifica as  soldas,  identifica e  remove o  curto-circuito.
Existe  ainda a  baixa  probabilidade de um componente
estar danificado.

Os  reguladores  de  tensão  não
aqueceram, o LED ON não acende ou as
tensões do conector de alimentação do
Arduino não estão presentes. 

É provável que haja “soldas frias” e o contacto entre os
componentes e a placa é deficiente. Identifica as soldas
frias, em que o estanho não brilha, e encosta o ferro de
soldar até que vejas a solda a derreter completamente.
Aplica novamente solda nos casos em que for necessário.

Os  reguladores  de  tensão  não
aqueceram,  as  tensões  do  conector  de
alimentação do Arduino estão presentes
mas o LED ON não acende.

Deverás confirmar que soldaste o LED ON respeitando a
polaridade  em  que  o  + corresponde  ao  perno  mais
comprido. Confirma com o multímetro a polaridade do
LED ON.

Depois de verificar todos os casos acima
descritos o problema subsiste.

Contacta o serviço de apoio da botnroll.com.
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4.3.3. INSERÇÃO DOS CIRCUITOS INTEGRADOS

Um  circuito  integrado  é  um  circuito  eletrónico  miniaturizado
composto  sobretudo  por  dispositivos  semicondutores  como
transístores.  O  número  de  transístores  dos  circuitos  integrados
pode variar  de um par  de transístores  a  dezenas de milhões de
transístores.

Na placa são utilizados dois integrados com o formato
DIP:

PIC18F45K22:  unidade  de  processamento  de  40  pinos
(PIC).

ATmega328:  unidade  de  processamento  de  28  pinos
(Arduino).

NOTA: Antes  de  introduzires  os  circuitos  integrados
certifica-te de que o Bot’n Roll ONE A está desligado.

Poderá  ser  necessário  alinhar  os  pinos  dos  circuitos
integrados  para  os  inserires  no  respetivo  suporte.  Faz
isto com cuidado pois os pinos são frágeis e podem partir
se os dobrares várias vezes, ficando o circuito integrado
irremediavelmente destruído. 

NOTA  IMPORTANTE:  Os  integrados  têm  uma  única
posição de inserção. Numa das extremidades existe uma
cavidade que deverá corresponder à marca impressa na
serigrafia no PCB. 
Coloca  o  integrado  ATmega328  em  U1 e  o  integrado
PIC18F45K22 em U2.
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Fig. 56 Inserção dos Circuitos Integrados

Descrição Componente
U1 ATmega328
U2 PIC18F45K22
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4.3.4. FIXAÇÃO DA PLACA NA BASE DE ACRÍLICO

A  fixação  da  placa  do  robô  na  base  de  acrílico  é
efetuada  através  de  6  conjuntos,  cada  um  com  um
espaçador de nylon de 12mm, um parafuso M3x8 PH1
e outro M3x4 PH1.

Insere cada parafuso M3x8 PH1 na base de acrílico de
baixo  para  cima e  rosca  um espaçador  de  nylon até
conseguires um bom aperto. 

Repete o processo para cada um dos seis espaçadores.

Coloca a placa eletrónica do robô passando os cabos
dos motores pelo orifício da placa e fixa-a roscando os
parafusos M3x4 PH1 nos espaçadores de nylon.

Aperta os parafusos com uma chave de cruz de forma a
que  não  existam  folgas  entre  a  placa  do  robô,  os
espaçadores de nylon e a base de acrílico.

4.3.5. LIGAÇÃO DOS MOTORES

A  ligação  dos  motores  é  efetuada  nos  conectores
MotorL e MotorR. O motor esquerdo liga em MotorL
e o direito em MotorR.

NOTA IMPORTANTE:  Os fios dos motores têm duas
cores: um fio é preto e outro vermelho. É importante
ligar  corretamente  estes  fios  pois  a  polaridade
determina o sentido de rotação do motor.

O fio vermelho liga na descrição “+” e o fio preto na
descrição “–”.
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Fig. 58: Montagem da placa de circuito
impresso na base de acrílico

Fig. 59: Ligação dos Motores

Fig. 57: Material para fixação da placa
na base de acrílico.



Manual de montagem Bot’n Roll ONE A

4.3.6. COLOCAÇÃO DA BATERIA

A bateria é colocada na parte inferior da base de acrílico
através de duas tiras de velcro. 

Antes de colocares as tiras de velcro verifica que as zonas
de  colagem  na  bateria  e  no  acrílico  não  contenham
sujidade nem gordura! 

Se  necessário  usa  um  produto  de  limpar  vidros  para
limpar as superfícies e deixa secar bem!

Cola as tiras de velcro na bateria fazendo pressão para
uma aderência  eficaz.   Remove de seguida a  proteção
dos autocolantes para colocação da bateria no robô.

Coloca a  bateria  no Bot'n Roll  ONE A fazendo pressão
mais uma vez para uma boa aderência. Atenção para não
danificares os componentes da placa o robô!

Depois  de  a  bateria  estar  fixa  com  o  velcro  e
completamente carregada, liga o conector e o teu Bot’n
Roll ONE A está pronto para ser programado!

Muito bem! 
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Fig. 60: Colocação da bateria
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5. INSTALAÇÃO DO VCP DRIVER DO CONVERSOR USB-SÉRIE (RS232)

O driver permite que o sistema operativo do teu computador comunique com o Bot'n Roll ONE A.

Para instalares o driver visita a página de suporte do Bot’n Roll ONE A http://botnroll.com/onea/ e faz
download clicando em "VCP Driver -  Windows" ou "VCP Driver -  Mac OS X" de acordo com o teu
sistema operativo. Assim que terminar o download descompacta o ficheiro “.zip” e executa a aplicação.

Sempre que ligares o robô ao computador usando o cabo USB é criada uma porta COM virtual (VCP)
pela qual é efetuada a comunicação entre o Bot'n Roll ONE A e o PC. A aplicação para a programação do
robô usa esta porta para comunicar com o Bot'n Roll ONE A e desta forma transferir os programas para
o robô.

O conversor USB-Série utilizado no Bot'n Roll ONE A é um PoUSB12 da PoLabs e usa o dispositivo Bridge
CP2102 da Silicon Labs.

6. AMBIENTE DE PROGRAMAÇÃO ARDUINO

O software utilizado para a programação do robô é o Arduino IDE. Esta aplicação é necessária para fazer
a edição dos programas em linguagem C. Serve também para transferir os teus programas para o Bot’n
Roll ONE A.

6.1. INSTALAÇÃO DO ARDUINO IDE

Para  a  instalação  do  Arduino  IDE,  visita  a  página  de  suporte  do  Bot’n  Roll  ONE  A
http://botnroll.com/onea/ e nos downloads essenciais clica em "Arduino IDE - Windows" ou "Arduino
IDE - Mac OS X" de acordo com o teu sistema operativo.

Assim que o download terminar, descompacta o ficheiro .zip e coloca a pasta extraída numa diretoria do
teu computador a teu gosto. 

Esta pasta contém várias subpastas  e ficheiros,  entre eles,  a aplicação "arduino",  o executável  que
arranca o Arduino IDE. A subpasta "libraries" também é muito importante e contém todas as bibliotecas
do ambiente Arduino. As bibliotecas são as tuas ferramentas de trabalho em programação.

6.2. INSTALAÇÃO DA BIBLIOTECA BNRONEA PARA ARDUINO

A biblioteca  BnrOneA  desenvolvida pela  botnroll.com para o Arduino IDE possui todos os comandos
necessários para o controlo do robô. Esta biblioteca deve ser instalada no Arduino IDE.

Na  página  de  suporte  do  Bot’n  Roll  ONE  A  http://botnroll.com/onea/,  faz  download do  ficheiro
BnrOneA.zip clicando em "Biblioteca Arduino".

Descompacta o ficheiro e coloca a pasta extraída "BnrOneA" dentro da subpasta "libraries" de que
falamos  no  ponto  anterior.  Possuis  agora  todas  as  ferramentas  necessárias  para  programares  com
sucesso o teu Bot'n Roll ONE A!
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6.3. CONFIGURAÇÃO DA COMUNICAÇÃO COM O ROBÔ

Antes de efetuares este passo, certifica-te que instalaste o VCP driver corretamente. Conecta o Bot’n
Roll  ONE  A  ao  computador  usando  o  cabo  USB  fornecido.  Neste  momento,  será  atribuída
automaticamente uma porta COM para a comunicação com o robô.

Abre o Arduino IDE e no separador "Tools ->
Board" seleciona a placa "Arduino Uno". O Bot
´n Roll  ONE A será programado como se  de
um Arduino Uno se tratasse.

No separador "Tools -> Serial Port" seleciona a
porta COM atribuída ao Bot'n Roll ONE A.

Se nenhuma porta COM estiver disponível, o mais certo é não teres instalado corretamente o VCP driver
do conversor USB-Série. 

Abre o gestor de dispositivos do Windows e procura o item
com a designação “Portas (COM e LPT) ”. Expandindo este
item, verás todas as portas COM atribuídas.

“Silicon Labs CP210x USB to UART Bridge” é a designação
que identifica a porta de ligação ao Bot’n Roll ONE A. (No
exemplo da figura foi atribuída a porta COM5.)

Caso  não  apareça  o  item  "Silicon  Labs  CP210x  USB  to
UART  Bridge"  terás  que  instalar  corretamente  o  VCP
driver.
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6.4. CARREGAR UM PROGRAMA PARA O BOT'N ROLL ONE A

No ambiente de programação Arduino encontras vários programas de exemplo que podes carregar para
o robô. 

Clica em "File -> Examples -> 01.Basics ->
Blink"  e  aparece uma nova janela  com o
código deste exemplo. 

Clica em "File -> Upload"  ou  carrega  no
símbolo com a seta para o lado direito para
enviar o programa para o robô. Assim que
o  upload terminar  deverás  ver  o  LED
amarelo L a piscar a cada segundo!

Clicando em "File -> Examples ->  BnrOneA-> ..." encontras  todos os  programas desenvolvidos pela
botnroll.com especificamente para o Bot'n Roll ONE A. 

Em "File -> Examples -> BnrOneA-> Basic -
> ..." estão os programas mais simples que
têm  como  finalidade  testar  todo  o
hardware do  robô.  Deverás  estudar  e
compreender  bem  estes  pequenos
programas!

Em  "File  ->  Examples  ->  BnrOneA->
Advanced  ->  ..." estão  programas  mais
avançados que só deverás estudar quando
perceberes os mais simples. 

Em "File -> Examples -> BnrOneA-> Extra -
> ..." são os programas relacionados com
os componentes extra que expandem o teu
Bot'n Roll ONE A.
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7. TESTE AO HARDWARE DO BOT'N ROLL ONE A

Depois do teu robô ter passado com sucesso no teste elétrico (ponto 3.3.2 do manual) é necessário
testar  individualmente  todos dispositivos do Bot'n  Roll  ONE A para verificar  que estão a  funcionar
corretamente. Para isso terás programar o robô com os códigos de exemplo correspondentes e efetuar
o teste descrito em cada um dos pontos seguintes, pela ordem indicada!

7.1. LED " L"

Usando o  Arduino  IDE  abre  o  programa de  exemplo  " Blink"  localizado  em " File  ->  Examples  ->
01.Basics -> Blink " e programa-o no robô clicando em "Upload". Assim que o upload terminar deverás
ver o LED L a piscar a cada segundo.

Se o LED  L não emitir luz  verifica se existem curto-circuitos ou
soldas frias nas soldas do(a): 

 LED L;
 Resistência R16;
 Pino 13 do conector 8-SCL do Arduino;
 Suporte do circuito integrado ATmega328. 

Verifica também que soldaste o LED L respeitando a sua polaridade. Conseguirás verificar isto usando
um multímetro ou comparando as ligações internas do LED com outro idêntico.

7.2. BUZZER

Carrega para o robô o programa de exemplo "Buzzer" localizado em "File -> Examples -> BnrOneA->
Basic  ->  Buzzer".  Assim que o  programa arrancar  no Bot'n  Roll  ONE A deverás  ouvir  uma melodia
emitida pelo buzzer. Isto indica que o buzzer está a funcionar corretamente.

Se o buzzer não tocar a melodia verifica que o jumper BUZZ está
corretamente colocado e se existem curto-circuitos ou soldas frias
nas soldas do(a):

 Buzzer;
 Resistência R15;
 Jumper BUZZ;
 Suporte do circuito integrado ATmega328.
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7.3. LED DE DEBUG "LED"

Carrega para o robô o programa de exemplo "LED" localizado em "File -> Examples -> BnrOneA-> Basic -
> LED". Assim que o upload terminar deverás ver o LED a piscar a cada segundo.

Se  o  LED não  emitir  luz  verifica  se  existem  curto-circuitos  ou
soldas frias nas soldas do(a):

 LED LED;
 Resistência R18;
 Pino 13 do conector 8-SCL do Arduino;
 Jumper SSP;
 Suporte do circuito integrado PIC18F45K22;
 Suporte do circuito integrado ATmega328.

Verifica também que soldaste o LED L respeitando a sua polaridade. Conseguirás verificar isto usando
um multímetro ou comparando as ligações internas do LED com outro idêntico.

7.4. LCD

Carrega para o robô o programa de exemplo "LCD" localizado em "File -> Examples -> BnrOneA-> Basic -
> LCD". Assim que o upload terminar será apresentada no LCD a mensagem "LCD Test OK!!".

Se não conseguires visualizar a mensagem verifica que:
 O interruptor geral do robô está ligado;
 Ajustaste o brilho do LCD usando o potenciómetro BR;
 Ajustaste  o contraste  do LCD usando o potenciómetro

CT.

Se não conseguires visualizar ainda a mensagem no LCD verifica
se existem curto-circuitos ou soldas frias nas soldas do:

 Conector de 16 pinos do LCD;
 Potenciómetro BR;
 Potenciómetro CT;
 Jumper SSP;
 Suporte do circuito integrado PIC18F45K22;
 Suporte do circuito integrado ATmega328.
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7.5. BOTÕES DE PRESSÃO

Carrega para o robô o programa de exemplo "PushButons" localizado em "File -> Examples -> BnrOneA-
> Basic -> PushButons". Assim que o upload terminar será indicado no LCD qual o botão que está a ser
pressionado:

 0 se nenhum botão pressionado
 1 se PB1 pressionado
 2 se PB2 pressionado
 3 se PB3 pressionado

Se  algum  dos  botões  não  funcionar  verifica  se  existem  curto-
circuitos ou soldas frias nas soldas do(a):

 Interruptor PB1;
 Interruptor PB2;
 Interruptor PB3;
 Resistência R6;
 Resistência R7;
 Resistência R8;
 Jumper SSP;
 Suporte do circuito integrado PIC18F45K22;
 Suporte do circuito integrado ATmega328.

7.6. BATERIA

Carrega para o robô o programa de exemplo "Battery" localizado em "File -> Examples -> BnrOneA->
Basic -> Battery". Assim que o upload terminar será apresentada no LCD a tensão da bateria.

Se o valor da bateria não estiver entre 9.0V e 14.0V verifica que:
 O interruptor geral do robô está ligado;
 A bateria está carregada;
 A resistência colocada em R2 é de 3.3KΩ;
 A resistência colocada em R3 é de 10KΩ;
 Colocaste o díodo Zener Z1 com a orientação correta.

Se  o  problema  persistir  verifica  se  existem  curto-circuitos  ou
soldas frias nas soldas do(a):

 Condensador C1;
 Resistência R2;
 Resistência R3;
 Díodo Z1;
 Jumper SSP;
 Suporte do circuito integrado PIC18F45K22;
 Suporte do circuito integrado ATmega328.
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7.7. MOTORES

Carrega para o robô o programa de exemplo "Motors" localizado em "File -> Examples -> BnrOneA->
Basic -> Motors". Assim que o upload terminar os motores deverão mover o robô e será apresentada no
LCD uma mensagem com o movimento efetuado.

Se algum dos motores não se mover verifica que:
 O interruptor geral do robô está ligado;
 A bateria está carregada;
 O conector MotorL está bem apertado;
 O conector MotorR está bem apertado;
 Os hubs estão bem colocados nos motores;
 As rodas do robô estão bem apertadas nos hubs.

Se  o  problema  persistir  verifica  se  existem  curto-circuitos  ou
soldas frias nas soldas do(a):

 Condensador C2;
 Díodos D2, D3, D4, D5, D6, D7, D8 e D9;
 Conetor MotorL;
 Conetor MotorR;
 Circuito integrado U3 (L298N);
 Jumper SSP;
 Suporte do circuito integrado PIC18F45K22;
 Suporte do circuito integrado ATmega328.

7.8. LED'S DE INFRAVERMELHOS

Carrega para o robô o programa de exemplo "_01_EmittersOnOff" localizado em "File -> Examples ->
BnrOneA-> ObstaclesSensor ->  _01_EmittersOnOff".  Assim  que  o  upload terminar  os  LED’s  de
infravermelhos irão comutar a cada segundo com respetiva indicação do seu estado no LCD. 

Usa  a  câmara  de  um  telemóvel  que  não  tenha  filtro  de  infravermelhos  para  verificar  o  correto
funcionamento dos LED's, pois os olhos de um humano não conseguem ver este tipo de luz.

Se algum dos LED's não emitir luz ajusta o potenciómetro correspondente ( IRD1 para o IRE1 e IRD2 para
o IRE2) até veres luz a ser emitida pelo LED.

Se  o  problema  persistir  ou  se  algum  dos  LED's  não  comutar
verifica se existem curto-circuitos ou soldas frias nas soldas do(a):

 LED IRE1;
 Transístor Q1;
 Potenciómetro IRD1;
 Resistências R13 e R24;
 LED IRE2;
 Transístor Q2;
 Potenciómetro IRD2;
 Resistências R19 e R25;
 Jumper SSP;
 Suporte do circuito integrado PIC18F45K22.
 Suporte do circuito integrado ATmega328.
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7.9. SENSORES DE OBSTÁCULOS

Carrega para o robô o programa de exemplo "_02_ObstaclesRead" localizado em "File -> Examples ->
BnrOneA-> ObstaclesSensor ->  _02_ObstaclesRead".  Assim  que  o  upload terminar  os  LED’s  de
infravermelhos irão emitir luz infravermelha que ao ser refletida para os sensores de obstáculos farão
acender os LED's IRS1 e IRS2. 

No LCD será apresentada uma mensagem com a indicação do valor de proximidade do obstáculo a cada
sensor e que varia entre 0 e 25:

 0  o sensor não deteta obstáculo;
 25 o obstáculo está muito próximo do robô.

Coloca a mão em frente aos LED´s de infravermelhos simulando um obstáculo e verifica que os LED's
IRS1 e IRS2 cintilam e que ao mesmo tempo a respetiva mensagem é apresentada no LCD.

Se algum dos LED's  IRS1 ou  IRS2  não cintilar verifica se existem
curto-circuitos ou soldas frias nas soldas do(a):

 LED IRS1;
 Sensor IRR1;
 Resistência R14;
 LED IRS2;
 Sensor IRR2;
 Resistência R20;
 Jumper SSP;
 Suporte do circuito integrado PIC18F45K22.
 Suporte do circuito integrado ATmega328.

Verifica também que soldaste os LED's IRS1 ou IRS2 respeitando a sua polaridade. Conseguirás verificar
isto usando um multímetro ou comparando as ligações internas dos LED's com outro idêntico.

Coloca o robô em frente a um obstáculo, como uma parede ou folha branca e calibra a distância de
deteção de obstáculos ajustando os potenciómetros IRD1 e IRD2 com uma chave para o valor desejado.
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7.10. CALIBRAÇÃO DOS MOTORES

Carrega para o robô o programa de exemplo "MotorsCalibrate" localizado em "File -> Examples ->
BnrOneA-> Advanced  ->  MotorsCalibrate".  Assim  que  o  upload terminar  vais  ajustar  a  potência
necessária para colocar o robô em movimento. 

A calibração dos motores deverá ser feita com a bateria totalmente carregada e com o robô pousado
numa superfície plana! O objetivo deste processo é de registar a potência necessária para o robô iniciar
o movimento e a tensão da bateria nesse momento. O robô vai usar estes valores de calibração para
melhorar o movimento com velocidades muito baixas e para manter uma velocidade constante dos
motores à medida que a bateria vai descarregando.

No LCD é indicada a potência (PWM de 0 a 100) que está a ser aplicada aos motores. Usando o botão de
pressão  PB1 vais  aumentar a potência até o robô começar a mover-se em frente.  Nesse momento
levantas o robô e carregas no botão de pressão PB3 para registar os valores de calibração na memória
do robô. Uma mensagem indica que os valores foram registados.

Esta calibração deverá ser efetuada novamente se trocares a bateria por outra que tenha uma tensão
nominal diferente ou se trocares os motores.

O teu Bot'n Roll ONE A está agora completo e funcional! Usa a tua imaginação e explora o fantástico
mundo da Robótica… Muitos parabéns!
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8. EXTRAS

Um vasto conjunto de componentes podem ser integrados no Bot’n Roll ONE A e assim aumentar as
suas funcionalidades. Shields compatíveis com Arduino como comunicação sem fios XBee, Bluetooth ou
RF, GPS, GPRS, seguidor de linha, sonares, bússola, sensores e dispositivos I2C, encoders podem ser
adicionados ao teu Bot’n Roll ONE A e a imaginação é o limite!

No  manual  dos  extras  encontras  uma descrição  detalhada  de  alguns  destes  componentes.  Visita  a
página de suporte do Bot’n Roll ONE A http://botnroll.com/onea/ para obteres o manual respetivo.

Também  podes  visitar  o  website www.botnroll.com para  mais  informações.  Para  qualquer
esclarecimento visita o fórum www.botnroll.com/forum.
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9. ANEXOS

9.1. LISTA DE COMPONENTES DA PLACA ELETRÓNICA DO BOT'N ROLL ONE A

Qtd       Descrição Qtd       Descrição
3 Resistência de 120 Ohm 1 IC LM7805CT 

13 Resistência de 1K 1 IC LD33CV 
3 Resistência de 3,3K 1 Suporte IC 28 pinos 
5 Resistência de 10K 1 Suporte IC 40 pinos 
1 Resistência de 1M 2 Led emissor de infravermelhos 
4 Potenciómetro 10K 2 Recetor IR VISHAY TSSP4056 
1 Led Verde 3mm 1 Conversor USB-Série POUSB12
2 Led Vermelho 3mm 2 Transístor PNP BC557 
2 Led Amarelo 3mm 1 Buzzer - Transdutor Magnético 
2 Condensador 33pF 1 Display LCD 16x2
7 Condensador 100nF 1 Conetor pente de 16 pinos
2 Condensador 100uF 25V 4 Botões de pressão
1 Cristal 16MHz 1 Interruptor geral

12 Díodo FR203 1 Conetor fêmea 10 pinos
1 Díodo Zener 5V1 2 Conetor fêmea 8 pinos
1 Fusível lento de 3A 20x5mm 1 Conetor fêmea 6 pinos
1 Base Suporte de fusível 1 Conetor pente 3x2
1 Tampa Suporte de fusível 2 Conetor KK macho 4 pinos
1 IC Atmega328 3 Conetor com parafuso 2 pinos 
1 IC PIC18F45K22 2 Conetor jumper de 2 pinos
1 IC L298N 1 Conetor jumper de 3 pinos
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9.2. ESQUEMA ELÉTRICO
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